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11  Installation and Startup 

 

1.1 Introduction 

Welcome and thank you for using Origin 8.1! In this guide, unless otherwise noted, "Origin" will 

be used to refer to both Origin and OriginPro.  

Origin 8.1 is a Windows application. You can run Origin on an Intel-based Mac if you have 

installed a virtualization software and set up a virtual computer with Windows installed on it. 

For more information, see the OriginLab website.  

There are three steps that must be completed to prepare Origin for use:  

 Installation  

 Selection of a User Files Folder  

 License Management  

An Administrator log in account is required to install Origin. However, for selection of a User 

Files Folder and for completing the license management, Administrator permissions are not 

needed.  

1.2 Installing Origin 

Both the Origin 8.1 Product and the Upgrade install into a new program folder - the Upgrade 

does not update a previous version. Thus, if installing an Origin Upgrade, you do not need to 

have your previous version of Origin installed, although you can have it installed.  
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The startup program that launches when you insert the Origin 8.1 CD in the CDROM includes 

an Origin 8.1 installation button. If this startup program does not run automatically, you can 

browse the CD to launch the startup program, or browse the CD to launch the Origin 8.1 

installer.  

In addition to the Origin 8.1 script-based installer that runs from the CD startup program, an 

MSI installer is provided on the CD. The MSI installer is ideal for use at Origin 8.1 multi-user 

sites, as you can use the MSI installer to build an Origin installation package for distribution. 

Sample MSI transforms are provided on the CD.  

For more information on multi-user site deployment, see the Support area of the OriginLab 

website.  

Installation Settings 

The following information is entered or selected during an Origin 8.1 installation:  

 User and organization name  

 Origin serial number  

 Origin destination program folder  

 Whether to install Origin Hel p documentation  

 Whether to install pre -compiled Origin files  

 Whether to install data import filters  

 Whether to allow this Origin to be available for all Windows log in users on the computer, or 

just the current Windows log in user  

 Program folder for th e Origin program icons  

How to Proceed if you already have the Origin 8.1 Evaluation 
Installed 

If you already have the Origin 8.1 Evaluation installed on your computer, you can convert the 

Evaluation into a Product or Upgrade. To do this, you must log into the computer with an 

Administrator account.  

Run the Origin 8.1 Add or Remove Files program located in the Origin program icon folder. 

Alternatively, re-run the Origin 8.1 installer. In both cases, the Origin Setup program displays 

providing options to Modify, Remove or Repair. Select the Modify option and click Next. Then 

select "Install Product (requires serial number)" and click Next. Proceed on as prompted to 

complete the conversion process.  
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How to Make Corrections and Changes After you Complete an 
Installation 

If you installed Origin with an incorrect serial number, or if you did not install the Help files or 

the pre-compiled Origin files and you later want them installed, you can make these changes 

by running the Origin 8.1 Add or Remove Files program located in your Origin program icon 

folder. In both cases, select the Modify option in the Origin Setup program and click Next.  

 To correct a serial number, click Yes to change your serial number and proceed as prompted.  

 To install the Help or pre -compi led Origin files, click No to change your serial number and 
proceed as prompted.  

If you selected "Current user only" in the All Users or Current User Setup page and you meant 

to select "All users", or the other way around, you can correct this by editing the InstInfo.INI file 

located in your Origin 8.1 program folder. This file contains an [OriginUsers] section with one 

line of text:  

LogonUserName=value  

You can set value to AllUsers or you can set it to the log in user name you want to restrict 

access to. After you make this change and restart Origin, you may see a licensing dialog box 

again. In this case, repeat the licensing process as directed.  

1.3 Uninstalling Origin 

To uninstall Origin, run the Origin 8.1 Add or Remove Files program located in the Origin 

program icon folder, or use the Windows "uninstall a program" tool. In both cases, the Origin 

Setup program displays providing options to Modify, Remove or Repair. Select the Remove 

option and complete the wizard as prompted.  

The Remove program deletes all folders and files that were installed by the Origin 8.1 setup 

program. It also deletes folders and keys created by the installer in the Windows Registry.  
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1.4 Selecting a User Files Folder 

After installing Origin, each Windows log in user that runs Origin must select a User Files 

Folder at their first Origin startup. The User Files Folder is the default file save and open 

location for that log in user, for saving and reading custom graph templates, fitting functions, 

themes and other Origin files.  

Consider these points in selecting your User Files Folder:  

 If you have a mobile computer, it is best to select a User Files Folder location on your 
computer rather than on your network.  

 For non -mobile computers, you can select a User Files Folder location on the  computer or the 

network, as long as you have stable access to the folder.  

 Do not select the same User Files Folder as other Origin users, unless you want to share your 

custom files. For more information, see  Sharing Origin Files  .  

 If you upgraded from Origin 8.0 or 7.5, you must select an Origin 8.1 User Files Folder 
different from your Origin 8.0/7.5 User Files Folder. To learn how to transfer files from your 
8.0/7.5 folder t o your 8.1 folder, see Notes for Upgrade Users .  

At each Origin startup, Origin will check that your User Files Folder is accessible. If Origin 

cannot connect to the User Files Folder, you must select a new folder. Also, a Tools:Change 

User Files Folder menu command is provided to easily change the User Files Folder location.  

If you are deploying Origin to multiple computers, or if there will be multiple log in users running 

Origin on a computer, you may consider presetting the User Files Folder location. This can be 

done by editing the Path key in the [User Files] section of the Origin.INI file, located in the 

Origin program folder. Comments are provided in the Origin.INI file to assist you.  

For more information on multi-user site deployment, see the Support area of the OriginLab 

website.  

1.5 Licensing Origin 

All Origin packages include license management. The type of license management provided 

with your package is determined at the time of your Origin purchase. License management 

models include, but are not limited to, the following:  
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 Concurrent network management -  A FLEXnet license server is set up to provide the license 

management. All Origins connect to the FLEXnet license server to check out a license. The 
license server counts and restricts the number of Origins that can run concurrently.  

 Node - locked license management -  Each Origin computer requires a license file to run. The 
number of licenses available is restricted to the purchased number.  

 Dongle -  A dongle (USB hardware key) is provided with the Origin package and must be 
present in the computer's USB port to run Origin.  

The Origin licensing process does not require a Windows log in account with Administrator 

permissions. Furthermore, once Origin is properly licensed, then it is licensed for all log in 

users on that computer.  

For all packages except dongle management, a licensing dialog box will display when you first 

start Origin. This same licensing dialog box will display on future startups - if Origin remains 

unlicensed. You must complete the licensing process to use Origin.  

 In the node - locked package, use the licensing dialog box to obtain a license for the computer 

from the OriginLab website. I f the computer does not have internet access, select that option 
in the dialog box to learn how to complete the process.  

 In the concurrent network package, use the licensing dialog box to enter the location of the 
FLEXnet license server.  

For information on setting up the concurrent network license management, see the guide 

provided in your Origin concurrent network package or see the Support area of the OriginLab 

website.  

1.6 Registering Origin 

Registering Origin is a prerequisite for Origin support from OriginLab and the team of Origin 

Distributors. Also, registration activates the Origin Help:Check for Updates menu command. 

Check for Updates allows you to check if a patch or updated Help files are available for your 

Origin, and to obtain those updates. Thus, although registration is optional, it is recommended.  

If you have an Origin package with node-locked license management, your Origin is 

automatically registered after you successfully complete the licensing process. You can verify 

this by selecting Help:About Origin. The About Origin dialog box will display the Registration 

ID assigned to your Origin package.  



1.7 Setting the Origin Display Language 

 Installation and Startup 6   

For all other license management packages, a Registration dialog box displays when starting a 

licensed - but unregistered - Origin. Use the Registration dialog box to register your Origin on 

the OriginLab website. During this process, a Registration ID is issued. Enter or copy/paste this 

Registration ID into the Registration dialog box to complete the process. The Help:About 

Origin dialog box will now display your Registration ID.  

1.7 Setting the Origin Display Language 

Origin packages sold to organizations in a limited number of countries including Japan, 

Germany, Switzerland, Austria, and Liechtenstein may support running Origin with English 

display or with Japanese or German display. This language control is available by selecting 

Help:Change Language.  
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2.1 The Origin Project 

The Origin Project file (.OPJ) combines data, notes, graphs, and analysis results in one 

flexibly structured document. All components of the Origin Project can be interactively 

accessed when the project file is opened in Origin. The Origin Project file can also contain 

internally saved Microsoft Excel files or links to external Excel files, LabTalk script and Origin C 

code files, and third party files as attachments.  

Combined with the ability to recalculate results on change of input data or change of analysis 

parameter settings, the Origin Project can function as an Analysis Template for performing 

repeat analysis on similar data.  

The dockable Project Explorer window in the Origin interface helps you organize and interact 

with various components of the Origin Project. Components such as workbooks, matrix 

books, graph pages, and notes windows can be organized in a user-defined folder structure 

with the flexibility of creating subfolders to any desired level. In a given Origin session, only one 

Origin Project file (or OPJ) can be opened in Origin, although one could append multiple files 

from disk, or save a particular folder, and subfolders there-in, to a separate OPJ file on disk. 

Individual windows, such as workbooks and graphs, can also be saved to disk and opened in 

order to be added to the currently open project.  
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Project Explorer is similar in form and function to Windows Explorer. The component windows 

can be sorted by name, date, size or time, and options are provided to display additional 

properties such as window Long Names, or window order within a given subfolder. Context 

menus in Project Explorer provide various options including launching a slide show of all 

graphs contained within a folder, or appending other Origin Project files from disk.  

Recognition and understanding of the organizational structure of the Origin Project, combined 

with a good understanding of the structure and features of the Origin Workbook and Matrix 

book, is important to make efficient use of these features to organize your data and associated 

graphs, notes, and analysis results in the most optimal form based on your specific needs.  
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2.2 Hierarchy of Origin Objects 

The following sections provide basic information on the hierarchy of the Workbook, Matrix 

Book and Graph Window objects in Origin. Further details on the hierarchy of these and other 

objects can be found in the Origin Help file.  

Workbooks 

The Origin Workbook is organized as a collection of Worksheets. A workbook can contain 

multiple worksheets - also known as Layers - each identified by a unique name and can be 

referenced by name or index numbered left to right.  

A worksheet contains a collection of Columns. Each column can be set to one of many data 

formats such as Text & Numeric, Numeric, Text, Date or Time. Individual cells or groups of 

cells in a column can be formatted by customizing properties such as font, color, or number of 

decimal digits for the display. However a single column can contain only one type of data at a 

given time. Columns can be referenced by name or index numbered left to right.  

All columns have fixed properties (or metadata) situated in Label Rows at the top of each 

column, that include a Short Name, a Long Name, Units and Comments. The values of 

these properties are used to address and represent the data columns within the Origin 

graphical interface, including various dialogs. Such properties are also utilized to annotate 

graphs when graphs are created from data stored in worksheet columns. You can also add 

custom label rows called User Parameters that can be assigned arbitrary names.  

Numeric data stored in a column can be graphically displayed in the column header in a 

special label row named Sparklines. A column's sparkline is a small inset plot of the data in 

that column, which is plotted as the dependent variable (Y) versus the row number as the 

independent variable (X). Origin displays sparklines by default when data is imported into the 

columns. The display of sparklines can also be turned on or off by the user from the Column 

menu or from the context menu available when right-clicking on the column header.  

Worksheet columns also have a Plot Designation property that includes the designations X, 

Y, Z, Y Error and Label. This plot designation property allows for graphs to be quickly created 



2.2 Hierarchy of Origin Objects 

 Introduction to Origin 8.1 10   

by selecting columns, and is also used by various dialogs in Origin to automatically recognize 

and assign input data for various operations such as curve fitting.  

The Column Properties dialog allows you to customize various properties of the column 

including name, plot designation, format and subformat. This dialog is accessible by double-

clicking on the column header and also from the right-click context menu.  

 

The Set Column Values entry in the Column menu opens a Set Values dialog which can be 

used to fill a column with values. The formula can refer to other columns in the same sheet, 

and can utilize various mathematical, statistical, and other functions available from the F(x) 

menu in the dialog. The Before Formula Script panel at the bottom of the dialog can be 

utilized to execute any LabTalk script prior to computation of the main column formula. The 

Variables menu provides a flexible interface to insert appropriate LabTalk script commands to 

access columns and other metadata contained in any sheet or book in the Origin Project.  

 

Various properties of the workbook can be customized using the Worksheet Properties dialog 

accessible from the Format menu. Worksheet cells can contain links to cells in other 
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worksheets or report sheets, and can also contain embedded graphs and images from external 

disk files, or images corresponding to matrix objects contained in the Origin project. Groups of 

cells in a worksheet can be merged, allowing for objects such as embedded graphs to be 

displayed over a larger area. These features when combined allow for the worksheet to be 

utilized as a flexible document for creating custom reports that summarize graphs, images and 

results. Such custom reports created using the worksheet can then be exported as image files 

such as PDF or JPEG, and can be also used for presenting results as part of Analysis 

Templates.  

 
 

The workbook can also contain additional metadata such as properties of data files imported 

into the worksheet including variables that may have been extracted from header lines 

contained in the data file. Such metadata can be viewed in the Workbook Organizer panel 

accessible in the right-click context menu on the worksheet window title. The metadata is then 

available for access in dialogs such as the Set Values dialog for setting column values.  
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Matrix Books 

The Matrix Book in Origin is a collection of Matrix Sheets or Layers. Each matrix sheet can in 

turn contain multiple Matrix Objects. Each matrix object is a two-dimensional array of 

numbers. The data types supported include floating point, integer and complex.  

 
 

Each matrix object has associated X and Y coordinates. You can assign arbitrary begin and 

end values for X and Y coordinates, and those values will be used to create a linear map of 

coordinate values in X and Y. The coordinate values are used by Origin to set the axes when 

creating plots such as 3D Surface or Contour plots from the matrix data, and also by analysis 

operations such as surface fitting.  
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The matrix dimensions and coordinates can be customized using the Matrix Dimensions 

dialog. The matrix data type and display can be controlled using the Matrix Properties dialog. 

Both dialogs are accessible from the Matrix menu. All matrix objects contained in a given 

matrix sheet share the same dimensions property (number of cells in X and Y) although each 

can have different settings for properties such as data type and display.  

The Set Values dialog also accessible from the Matrix menu allows you to specify formula for 

generating the numbers in a matrix.  

 
 

When a matrix contains numeric data, the top right corner of the window display a D icon. A 

matrix object can also contain an image such as an image imported from a disk file, instead of 

numeric data. When a matrix object contains an image the top right corner displays an I icon. 

Basic image processing tools in Origin can operate on images stored in matrix objects. Images 

can converted to numeric data and vice versa using menu items under the Image menu.  

The matrix window can display only one matrix object from one matrix sheet at a given time. 

Whether the matrix object contains an image or numeric data, the display can be toggled 

between Data Mode and Image Mode using the View menu. In Data Mode the display can 

also be toggled to either show the X and Y index or the actual X and Y coordinates using the 

View menu.  
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Graph 

An Origin Graph Page can contain multiple Graph Layers where each layer is comprised of a 

set of axes. Each graph layer can in turn contain multiple Data Plots. A Data Plot is simply a 

plot of one dataset.  

Graph layers can be separate from each other or can physically overlap each other in the 

graph page. The axes in layer can also be linked to axes of other layers. This hierarchy 

provides a very flexible way to present multiple data plots in a graph in multiple layers, at the 

same time maintaining desired relationships between the data plots.  

 
 

The Plot Details dialog accessible from the Format menu or by double-clicking on a data plot, 

provides a hierarchical interface for setting properties of the graph:  
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 Page level -  Page dimensions, colors, legend, etc.  

 Layer level -  Layer dimensions, linking, colors. etc.  

 Dataplot level -  Specific formatting for each plot style.  

 
 

Double-clicking on any axis of a layer opens the Axis Dialog which can be used to set 

properties of the axes such as tick directions, grid lines, and display format of tick labels.  

 

 



2.3 Themes and Templates 

 Introduction to Origin 8.1 16   

The Plot Setup dialog accessible by double-clicking on the Layer Icon provides a flexible 

interface for adding or removing data plots from the graph layers, reordering data plots, and 

other operations such as grouping or un-grouping plots in a layer. This dialog also opens when 

user selects a particular graph template without pre-selecting data columns. In this mode the 

dialog becomes the primary tool for creating new plots using an existing template, and it offers 

flexibility of selecting multiple data sheets in the project, and also flexible assignment of data 

columns such as which column to use for X and which column for Y in case of a 2D plot.  

 

2.3 Themes and Templates 

The hierarchy of Origin objects such as graph pages, combined with extensive object 

properties, lends itself to creating custom settings for repeat use. Origin provides the concept 
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of Templates and Themes for customization, and these are described briefly in the following 

sections. For detailed information please refer to the Origin Help file.  

Templates 

Customization performed on objects such as a Graph page or a Worksheet can be saved as a 

Template for repeat use. For instance you can customize a graph page to add multiple layers, 

set relationships between layers, and further customize data plots and then save all of these as 

a Graph Template (.OTP) for repeat use. In fact Origin is shipped with close to 150 graph 

templates. You can further customize them or create new ones for your specific needs. Once 

you customize a graph, a graph template can be saved using the Save Template As menu 

item under the File menu. The template can then be accessed for plotting using the Template 

Library menu item available from the Plot menu.  

 
 

The concept of template extends to workbooks (.OTW) as well as matrix books (.OTM) where 

custom settings such as font, color, display format, custom header rows in the case of 

workbooks, and custom dimension and coordinate settings in the case of matrix, can all be 

saved as a template for repeat use.  

Origin extends the template concept also to Analysis Templates where even operations on 

data such as curve fitting with custom report sheets can all be saved as a template for repeat 
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analysis of similar data. Analysis templates and the ability to perform batch processing using 

such templates is described in another section in this booklet.  

Themes 

Origin also provides a Theme concept where a set of object properties can be saved as a 

theme file for repeat use. In the case of a graph window, a theme could be as simple as 

settings for direction of the axes tick marks, or can be as extensive as desired containing 

multiple graph object properties. Themes can also be save from a worksheet.  

In the case of graphs the theme concept provides you with the ability to quickly change the 

look of a graph. One could for example apply a Black and White graph theme to a graph 

containing elements of various colors, to make the graph ready for publication. Properties of 

objects in one graph can be applied to another graph in the same Origin Project using the 

theme concept. You can right click on a graph window and select the Copy Format context 

menu to select either all, or certain collections of properties such as font settings, and then 

right click on another graph and select Paste Format to apply the settings to that graph. Such 

copy and paste format procedure could be applied to single elements such as for copying only 

the settings of a scatter plot from one graph to another.  

 
 


